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User Guide  (v2-3)
All content in this user guide copyright 2013 by DNA Music Labs.
Pro Tools® is a trademark or registered trademark of Avid Technology, 
Inc. or its subsidiaries in the United States and/or other countries.
Contact us and find more support online at http://www.hotkeymatrix.com 

Thank you for purchasing the Hotkey Matrix from DNA Music Labs. With this tool, you will find that your work in Pro Tools® audio production software
will become faster, more fun, and more creative! It is easy to get started, and this guide gives you all the information you need.

System requirements and compatibility:

The Hotkey Matrix supports all versions of Pro Tools 8, 9, and 10, (and will be supporting Pro Tools 11 upon release) on Mac OS X and Pro Tools 10 on
Windows 7 & 8 (Note: Two shortcuts are not supported in Pro Tools 8: “duplicate playlist” and “new playlist.” The “clip gain increase” and “clip gain decrease” shortcuts are not 
supported in Pro Tools 8 or 9).

The computer system language and keyboard language must be set to English (unless you have a language localized version). You can find setup files
for other languages on the support page at http://hotkeymatrix.com. Currently, German and French are supported.

The Hotkey Matrix requires one available USB port.

Installation Windows:

1. From the included CD, copy the file Hotkey Matrix Windows (English) setup.zip to a local drive on your PC. Unzip the archive. Double-click
Cherry_Tools_58_EN.msi to run the installer for the Cherry Tools Designer utility, which will flash the ROM on the Hotkey Matrix.

2. After Designer is installed, double-click Hotkey Matrix V2-3 Windows setup (English).ccf. This will open the Designer utility with the correct
configuration file.

3. Plug the Hotkey Matrix into an available USB port. You should see a yellow checklight flash by the label for a moment, meaning the keyboard has 
been recognized by the computer. At the top of the Designer interface, click the Activate button and click through the next screen. There will be a short 
progress bar (it says it might take a few minutes, but it finishes within a few seconds). This will flash the keyboard. After this, your Hotkey Matrix is ready 
to use.

Please note! The included Cherry Tools Designer Utility is compatible with Windows XP, Vista, and Windows 7. It is not compatible with Windows 8. If you plan to use your Hotkey Matrix 
with a Windows 8 system, you just need to run the setup once on a compatible Windows PC, after that no further software is needed to use the Hotkey Matrix. You can just plug it in to 
any Windows PC and it should work.

Installation Mac OS:

1. Make sure Pro Tools is closed. From the setup CD, copy Hotkey Matrix PT pref config V2-3.app to your applications folder and double-click the file 
to run it. Click through the two dialogs and your system will be configured to use the Hotkey Matrix. This app makes changes to your Pro Tools 
preferences file. If you have to delete your preferences as part of Pro Tools troubleshooting, you will need to run this app again to enable full functionality 
of the Hotkey Matrix. Also, you must run the app for each user account who wants to use the Hotkey on a given computer. Pro Tools should always be 
closed before running this app.

2. There are a couple of simple changes to the Mac OS Keyboard system settings. Go to the System Preferences>Keyboard>Keyboard Shortcuts
page and click on Keyboard & Text Input in the left column. In the right column, uncheck the check box next to Move focus to the window drawer.
Important! If you are using Mac OS X Lion or Mountain Lion (10.7 or 10.8), you need to make the following changes: Go to System
Preferences>Keyboard>Keyboard Shortcuts. Select Mission Control in the left hand column. In the right column, de-select the checkbox next to the
two instances of "Mission Control."

3. Plug the Hotkey Matrix into an available USB port. If this is the first time you have plugged it into your computer, you may get a Mac OS system dialog
called Keyboard Setup Assistant. You can ignore this dialog and close it by hitting the red close window button (in the top left corner).

Getting Started

The Hotkey Matrix is designed to be immediately useful. Reading the legends printed on the keys is the easiest way to start. They are short
descriptions of the Pro Tools functions or commands that the key will execute when pressed. If you are a Pro Tools power user, most will be familiar to
you. If you are a beginner or an intermediate user, get started by picking a few commands that you already use, and use the Hotkey shortcuts to
replace your usual method of accessing the command.

The color coding of the Hotkey Matrix keys serves two purposes: to group the keys loosely by Pro Tools function category and to make them stand out
from each other for easy targeting. Most of the keys are grouped by color/function. Strategic single keys are given a different color and placement to
make them stand out from neighboring keys. The color coding by function is described in Chart 2, which is found on page 3 of this manual.

The method of learning the Hotkey Matrix keyboard shortcuts is similar to learning any keyboard shortcuts in a software application, but arguably
easier — one clearly labeled key, one command. You need to be aware that the shortcut exists, and make yourself practice using it. The first few
practice runs can feel awkward, because you might have to hunt for a shortcut or remember exactly how it works. However, after using a shortcut
three or four times, you will remember it.

One of the primary benefits of the Hotkey Matrix is that it is much easier to remember a single key shortcut than a complex series of modifier keys and
regular keys. Since there are limited keys on the regular computer keyboard, the default Pro Tools keyboard shortcuts can require holding down one,
two, three, or in some cases four modifier keys to execute a command.

The Hotkey Matrix also provides single key shortcuts to certain Pro Tools commands that don’t have default keyboard shortcuts!

Configuration suggestion: The Hotkey Matrix (and Pro Tools) will be more intuitive to use if you have the "Link Track and Edit Selection" option 
enabled under the Pro Tools Options menu. All of the Hotkey commands that reference a "selection" reference an edit selection. With that option
enabled, your track selection follows along, making it easy to navigate to various tracks by using the move selection up or down shortcuts.

http://www.hotkeymatrix.com
http://www.hotkeymatrix.com
http://hotkeymatrix.com
http://hotkeymatrix.com
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Hotkey Mastery:

The fastest way to learn the Hotkey Matrix and become a Pro Tools power user is to systematically try out every key and familiarize yourself with
each shortcut.

Open an existing project in Pro Tools. If you use MIDI sequencing, make sure it has at least one MIDI or Instrument track in it. Save it as “Test
Project” or something similar so you don’t have to worry about messing up an existing project.

Start anywhere on the Hotkey Matrix and begin to systematically try out the commands. If you don’t understand a particular shortcut or function,
you can refer to the detailed explanations included in Chart 3 which starts on page 4 of the User Guide. The Pro Tools reference manual will also
be helpful. After you have tried every key and have a basic understanding of what it does, you will have a working familiarity with all of the
shortcuts.

Next, make yourself use the Hotkey Matrix shortcut instead of your usual method for accessing a command whenever you arrive at an appropriate
task in your workflow.

If you are already a Pro Tools power user, you will quickly learn all of the shortcuts that are available. The next time you encounter the need for a
function that has a Hotkey Matrix shortcut, you will know that it exists, and roughly where it is on the Hotkey Matrix.

If you are not already a Pro Tools power user, this exercise will require more learning. It will give you a crash course in some of the advanced
features of Pro Tools that can make your workflow much faster and easier. It might take you several hours to complete, but it is time that you will
quickly make up as you become more fluid and proficient using the Hotkey Matrix with Pro Tools.

Divide and Conquer:

Instead of systematically learning the entire Hotkey Matrix right away, you can start with a few shortcuts for commands you use frequently. For
example, the duplicate selection is a useful command in almost any Pro Tools session. This is a yellow key, and you will find similar Edit
commands grouped around it. Other shortcuts that are very quickly learned are the “New Track” commands. In the heat of the creative process,
it’s nice to be able to pop up a new stereo aux track, or new MIDI track with the press of a single button.

Combining the two approaches works well — pick a few shortcuts to get started, then when you feel inspired to enhance your workflow, you can
learn new sections of the Hotkey Matrix. Remember, it’s always a good idea to use a test project for experimentation.

While not every Pro Tools command can fit on the Hotkey Matrix, the vast majority of commonly used Pro Tools shortcuts are represented when
paired with the default Pro Tools shortcuts on a standard computer keyboard. You can add in Hotkey Matrix shortcuts to your workflow at a rate
that works for you.

Detailed descriptions of the Hotkey Matrix layout and shortcuts:

Chart 1 is a representation of the Hotkey Matrix layout with the key legends.  On the Y-axis, the rows are labeled 1-8.  On the X-axis, the 
columns are labeled A-R.  This chart can be paired with Chart 3, which has notes and explanations for all the shortcuts.  You can find the 
relevant part of the chart by referencing the column letter/row number for the shortcut on this diagram.  For example, the duplicate selection 
shortcut is on key L6. 

Chart 2 gives a conceptual explanation of how the key colors are organized.

Chart 3 lists the letter/number for every key on the Hotkey Matrix in its first column.  It starts with key A1 (the show/hide track list shortcut) and 
continues across the rows.  So the next entry is for B1 (show/hide clip list), next is C1 (recall window config 1) and so on.  To learn more about 
a specific shortcut, find its entry in Chart 3 using this method.

Tip: Although the Hotkey Matrix functions independently from Pro Tools Keyboard Focus mode, we recommend Commands Keyboard Focus mode for
most tasks (it is active when the little square with the letters “a-z” the top right corner of the Edit Window track display is highlighted yellow). It gives
access to one-key shortcuts on the regular computer keyboard. See the Pro Tools Reference Guide for further information on Keyboard Focus.

Getting Started

The Hotkey Matrix is designed to be immediately useful. Reading the legends printed on the keys is the easiest way to start. They are short
descriptions of the Pro Tools functions or commands that the key will execute when pressed. If you are a Pro Tools power user, most will be familiar to
you. If you are a beginner or an intermediate user, get started by picking a few commands that you already use, and use the Hotkey shortcuts to
replace your usual method of accessing the command.

The color coding of the Hotkey Matrix keys serves two purposes: to group the keys loosely by Pro Tools function category and to make them stand out
from each other for easy targeting. Most of the keys are grouped by color/function. Strategic single keys are given a different color and placement to
make them stand out from neighboring keys. The color coding by function is described in Chart 2, which is found on page 3 of this manual.

The method of learning the Hotkey Matrix keyboard shortcuts is similar to learning any keyboard shortcuts in a software application, but arguably
easier — one clearly labeled key, one command. You need to be aware that the shortcut exists, and make yourself practice using it. The first few
practice runs can feel awkward, because you might have to hunt for a shortcut or remember exactly how it works. However, after using a shortcut
three or four times, you will remember it.

One of the primary benefits of the Hotkey Matrix is that it is much easier to remember a single key shortcut than a complex series of modifier keys and
regular keys. Since there are limited keys on the regular computer keyboard, the default Pro Tools keyboard shortcuts can require holding down one,
two, three, or in some cases four modifier keys to execute a command.

The Hotkey Matrix also provides single key shortcuts to certain Pro Tools commands that don’t have default keyboard shortcuts!
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Chart 1: Hotkey Matrix key layout with row numbers and column letters (used for referencing detailed descriptions in Chart 3)

Chart 2: explanation of key colors

Selection, Nav & Display
Navigate your project quickly and
bring up the right display with a 
push of the button!

Editing & Nudging
Move beyond mouse-based
editing with comprehensive editing
and nudge commands!

Track & Playlists
Create and manipulate your tracks
with ease! Playlist commands keep
your creative sessions moving fast
to better capture the moment.

File Functions & Settings
Change various project settings. The 
handy file functions give quick access
to tasks you do every session!

Selection

Show/Hide Interface

Navigation, Zooming, Track Views

Show and Hide Floating Windows

Nudge Commands

Editing Commands

Paste Special and Track Grouping

Select Unused and Clear Selected Clips

New Track Creation

Track Menu Commands

Playlist Commands

REC Input Solo Mute

File Functions

Settings
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Matrix 
Position

Key Legend Notes

A1 track list Quickly hides the track list in edit window for more screen real estate. Press 
again to show it. 

B1 clip list
Quickly hides the clip list in edit window for more screen real estate. Especially 
helpful if your clip list is wide because you are showing the full file path. 

C1 recall window
config 1

Each of these will only work if the corresponding Window Configuration has 
been created. To create window configurations, use the “set window config” 
shortcuts below these keys. Window configurations are incredibly useful. They 
are used to create specific layouts of windows and clips in Pro Tools.

Example: If you have a track that has three plug-ins inserted on it, open up all 
three plug-in windows (by Shift-clicking on them). Arrange them on the screen 
so you can see all the controls. Press the “set window config 1” key. You can 
name your window configuration or just hit Enter to use the default name. Now 
whenever you need to tweak parameters across multiple plug-ins, just hit the 
“recall window config 1’ key, and it will bring the plug-ins all back to the screen. 
This is great for plug-in chains on the master bus where you are often trying to 
get the set of plug-ins to interact how you want.

D1 recall window
config 2

Each of these will only work if the corresponding Window Configuration has 
been created. To create window configurations, use the “set window config” 
shortcuts below these keys. Window configurations are incredibly useful. They 
are used to create specific layouts of windows and clips in Pro Tools.

Example: If you have a track that has three plug-ins inserted on it, open up all 
three plug-in windows (by Shift-clicking on them). Arrange them on the screen 
so you can see all the controls. Press the “set window config 1” key. You can 
name your window configuration or just hit Enter to use the default name. Now 
whenever you need to tweak parameters across multiple plug-ins, just hit the 
“recall window config 1’ key, and it will bring the plug-ins all back to the screen. 
This is great for plug-in chains on the master bus where you are often trying to 
get the set of plug-ins to interact how you want.E1 recall window

config 3

Each of these will only work if the corresponding Window Configuration has 
been created. To create window configurations, use the “set window config” 
shortcuts below these keys. Window configurations are incredibly useful. They 
are used to create specific layouts of windows and clips in Pro Tools.

Example: If you have a track that has three plug-ins inserted on it, open up all 
three plug-in windows (by Shift-clicking on them). Arrange them on the screen 
so you can see all the controls. Press the “set window config 1” key. You can 
name your window configuration or just hit Enter to use the default name. Now 
whenever you need to tweak parameters across multiple plug-ins, just hit the 
“recall window config 1’ key, and it will bring the plug-ins all back to the screen. 
This is great for plug-in chains on the master bus where you are often trying to 
get the set of plug-ins to interact how you want.

F1
new 
mono
track

creates a new mono track

G1
new
stereo
track

creates new stereo track

H1
new
mono
aux

creates a new mono aux track

I1
new 
stereo
aux

create a new stereo aux track

J1 track active/ 
inactive

Makes selected tracks inactive if they are active or active if they are inactive

K1
delete
track

If there are no clips on the track(s), the track(s) will be deleted right away. If 
there are clips on the track(s), you will get a dialog asking you to confirm the 
deletion.

L1 new playlist Creates a new playlist for each selected track

M1 nudge left selection earlier these nudge the edges of your selection (as opposed to the edges of a selected 
clip).  Useful for editing automation data among other uses.

N1 nudge left selection later

these nudge the edges of your selection (as opposed to the edges of a selected 
clip).  Useful for editing automation data among other uses.

O1
move selection
earlier Incredibly useful commands for editing, selection, navigation. Simply make a 

selection to try them.

Important note: This is one of the commands that won’t work correctly unless 
you disable the Mac OS X default keyboard shortcut for "Move Focus to the 
Window Drawer" as described in the Installation section above.P1

move selection
later

Incredibly useful commands for editing, selection, navigation. Simply make a 
selection to try them.

Important note: This is one of the commands that won’t work correctly unless 
you disable the Mac OS X default keyboard shortcut for "Move Focus to the 
Window Drawer" as described in the Installation section above.

Q1 extend selection
to start

A quick way to select from your cursor to the beginning of the session (for 
example: if you are zoomed in and don’t want to zoom out to navigate manually 
for the selection).

R1 extend selection
to end A quick way to make a selection from the cursor to end of the session.  

A2 universe
The Universe display is right above the ruler. It gives you a visual overview of 
your whole session. It can be helpful to drag the bottom edge to make it bigger 
for viewing, then use this shortcut to get it out of the way.

B2 narrow/ wide faders only works in the Mix window

Chart 3:  Detailed Explanation of Shortcuts
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Matrix 
Position

Key Legend Notes

C2
set 
window config  1

See notes for the “recall window config” shortcuts (keys C1, D1, E1) for an 
example of how to use these. Note that the process for updating a window 
configuration is exactly the same as creating a new one.D2

set
window config 2

See notes for the “recall window config” shortcuts (keys C1, D1, E1) for an 
example of how to use these. Note that the process for updating a window 
configuration is exactly the same as creating a new one.

E2
set
window config 3

See notes for the “recall window config” shortcuts (keys C1, D1, E1) for an 
example of how to use these. Note that the process for updating a window 
configuration is exactly the same as creating a new one.

F2 new 
track

Brings up the standard “New Track” dialog box, but doesn’t create a track 
automatically like the other new track shortcuts. Instead you can choose your 
options, then press Enter.

G2
new
click
track

creates a new Click Track

H2
new
instrument
track

Creates a new stereo instrument track

I2
new
MIDI
track
(native)

Creates a new MIDI Track in standard versions of Pro Tools (or Pro Tools LE). 
The create new MIDI track command is the only command on the Hotkey Matrix 
that has a different key for PT HD and standard versions. When using with a PT 
HD system (or Complete Production Toolkit), this key creates a new VCA Track.

J2
new 
MIDI 
track
(HD)

Creates a new MIDI track in Pro Tools HD (or with the Complete Production 
Toolkit). When using PT Native or LE systems, this key will create a mono 
instrument track.

K2 duplicate
track

Brings up the Duplicate Tracks dialog. You can choose the options you want 
and press Enter. Your new tracks will be right below your selected tracks.

L2 duplicate
playlist

Super handy when you’re recording and you want to keep most of your current 
playlist, but you want to try another idea in a certain section of the track without 
losing your first idea.

M2 nudge right selection earlier
these nudge the edges of your selection (as opposed to the edges of a selected 
clip).  Useful for editing automation data among other uses.

N2 nudge right selection later

these nudge the edges of your selection (as opposed to the edges of a selected 
clip).  Useful for editing automation data among other uses.

O2 halve selection
Cuts the length of a selection in half. Very useful in conjunction with the “move 
selection” forward or backward by selection amount shortcuts, which are right 
above it.

P2 double selection
Doubles the length of a selection. Very useful in conjunction with the “move 
selection” forward or backward by selection amount shortcuts, which are right 
above it.

Q2 fit selection to screen Causes your selection to fill the screen horizontally

R2 zoom out
whole session

Quick way to zoom out to view your whole session.

A3 ruler: min:sec or 
bar:beat

If your project master timeline is set to Bars:Beats, this will show an additional 
ruler view right below with Minutes:Seconds. Works vice versa if your master 
timeline is set to Minutes:Seconds. Useful for maximizing Edit Window 
workspace area on smaller screens.

B3 ruler:
markers

Will expand or contract the timeline ruler to show your markers. Useful for 
maximizing working area in Edit Window on small screens.

C3 time operation

These are all windows which are normally opened from the Event MenuD3 tempo
operation These are all windows which are normally opened from the Event Menu

E3 event
operation

These are all windows which are normally opened from the Event Menu

F3
open
fade
dialog

Brings up the Fade Dialog for tweaking fade settings. You can close by hitting 
Enter or the Hide All Floating Windows key.

G3
record
enable
selected

Record enables selected tracks

H3 input
monitor

Toggles the Input Monitor mode on tracks that are record enabled (In Pro Tools 
HD this is the green “I” on the track header. In other versions of Pro Tools, this 
shortcut toggles the Track Auto Input mode)
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Matrix 
Position

Key Legend Notes

I3
solo
selected
tracks

Solos selected tracks

J3
mute
selected
tracks

Mutes selected tracks.

K3 previous track
view These move through the list of track views on the track header. For example, if 

you are currently showing the Volume Automation view, pressing “next track 
view” will quickly take you up to the Waveform view.  A great way to navigate to 
the various automation lanes.

L3
next track
view

These move through the list of track views on the track header. For example, if 
you are currently showing the Volume Automation view, pressing “next track 
view” will quickly take you up to the Waveform view.  A great way to navigate to 
the various automation lanes.

M3 decrease grid
value

Quickly change your grid resolution (for example: from 16th notes to whole bars 
for editing in bigger chunks).

N3
increase grid
value

Quickly change your grid resolution (for example: from 16th notes to whole bars 
for editing in bigger chunks).

O3 decrease waveform height Makes clip waveform height shorter

P3 increase waveform height Makes clip waveform height taller

Q3 waveform default
height

If the heights of your waveform displays have gotten to high or low, this quickly 
resets all clips to the default waveform height.

R3 fit all tracks
vertically

This will fit all of your tracks to the window In the edit window. If you have a lot of 
tracks, they will be made smaller to fit. If you have just a few, they will be made 
bigger to take up the whole window.

A4 I/O
(edit) This will show or hide the I/O track header In the Edit window.

B4
real-time
properties
(edit)

This will show or hide the real-time properties header in the Edit window.

C4 beat
detective Shows or hides the Beat Detective window

D4 video Shows or hides the Video window if you have a video track in your project.

E4 automation Shows or hides the automation function window.

F4 MIDI
editor shows or hides MIDI editor.

G4 send A

Shows the corresponding send view with a small fader next to the send. This 
shortcut works in the Edit Window and the Mix Window.

H4 send B

Shows the corresponding send view with a small fader next to the send. This 
shortcut works in the Edit Window and the Mix Window.

I4 send C Shows the corresponding send view with a small fader next to the send. This 
shortcut works in the Edit Window and the Mix Window.

J4 send D

Shows the corresponding send view with a small fader next to the send. This 
shortcut works in the Edit Window and the Mix Window.

K4 send E

Shows the corresponding send view with a small fader next to the send. This 
shortcut works in the Edit Window and the Mix Window.

L4 send assign Displays the assignments for sends A through E
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Matrix 
Position

Key Legend Notes

M4 decrease nudge
value The Nudge Value is shown at the top of the screen in a small window next to 

main counter window. The nudge units must be set with the mouse; they can be 
in Bars:Beats, Mins:Seconds, Time Code, Feet+Frames, or Samples. Whatever 
the nudge units are, these shortcuts will decrease or increase the value. So if 
the nudge value units are set to Mins:Secs, you can change the value from 1ms 
all the way to 1 sec. The appropriate setting varies depending on what you are 
trying to accomplish. For example, for detailed timing correction of audio, a 
nudge value of 1ms or 10ms is ideal. N4

increase nudge
value

The Nudge Value is shown at the top of the screen in a small window next to 
main counter window. The nudge units must be set with the mouse; they can be 
in Bars:Beats, Mins:Seconds, Time Code, Feet+Frames, or Samples. Whatever 
the nudge units are, these shortcuts will decrease or increase the value. So if 
the nudge value units are set to Mins:Secs, you can change the value from 1ms 
all the way to 1 sec. The appropriate setting varies depending on what you are 
trying to accomplish. For example, for detailed timing correction of audio, a 
nudge value of 1ms or 10ms is ideal. 

O4
decrease track
height
all Quick way to vertically resize all of your tracks

P4
increase track
height
all

Quick way to vertically resize all of your tracks

Q4
decrease track
height
selected Vertically resize only selected tracks

R4 increase track
height selected

Vertically resize only selected tracks

A5 select unused clips Useful for cleaning up a session, selects unused clips which can then be 
cleared with the “clear selected clips” shortcut (key B5)

B5 clear selected clips Clears selected clips.  Can be used with the “select unused clips”’ command 
next to it to quickly clean up a project.

C5 Project Shows or hides the Project Browser

D5 Workspace Shows or hides the Workspace Browser

E5 system usage Shows or hides System Usage display.

F5 color palette Show or hide color palette. Quick way to bring it up to color regions or tracks.

G5 strip silence Brings up the Strip Silence dialog.

H5
lock/
unlock
clips

Will lock or unlock selected clips (depending on their previous state). Keeps 
clips from being moved.

I5 quantize
clips

Will quantize audio or MIDI clips to the grid. Only affects clips that are selected 
in their entirety. Uses main grid value.

J5
trim
clip to
selection

If you have a selection in the middle of a clip, will delete parts of the clip that are 
outside of the selection.

K5 loop
clip

Brings up the Loop Clip dialog. You can select various options for how long to 
loop the clip out. 

L5 unloop
clip

Brings up the Unloop command from the Clip Menu. You must have a looped 
clip selected to use this function.

M5 nudge left edge earlier
Useful for making small adjustments to the edges of clips without having to 
zoom in to use the mouse. Goes by current nudge value (which of course can 
be changed using the decrease or increase nudge value shortcuts M4, N4)

N5 nudge left edge later

Useful for making small adjustments to the edges of clips without having to 
zoom in to use the mouse. Goes by current nudge value (which of course can 
be changed using the decrease or increase nudge value shortcuts M4, N4)

O5 decrease note height
Makes MIDI notes appear shorter or taller in MIDI edit windows

P5 increase note height

Makes MIDI notes appear shorter or taller in MIDI edit windows
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Matrix 
Position

Key Legend Notes

Q5 page screen
left

Pages the screen left or right in the Edit Window. In the Mix Window it will page 
the mixer left or right.

R5 page screen right

Pages the screen left or right in the Edit Window. In the Mix Window it will page 
the mixer left or right.

A6 save copy in

Commonly used File menu functions

B6 bounce
to disk

Commonly used File menu functions

C6 prefs Shows or hides Preferences

D6 undo history
Shows or hides Undo History. Click on the list to undo your steps after that point 
on the list

E6 memory
locations Shows or hides the Memory Location list.

F6 real time
properties

This will show or hide the real-time properties track header (used for MIDI 
sequencing) in the Edit window.

G6 heal separate heals (recombines) selected clips that were previously separated

H6 lock/unlock time
This is similar to the lock/unlock clip function, but only prevents moving the clip 
earlier or later in time. You can still move it up or down to different tracks or 
perform other editing tasks on it (like separate).

I6 consolidate
selection

A command from the Edit Menu, creates new clips by combining all clips and 
areas of clips that have been selected. Selection can be across multiple tracks 
(even the whole session). In that case, the clips on each track are combined to 
make a new contiguous clip on that track.

J6 shift
selection

brings up the Shift Selection dialog. Useful for moving a clip earlier or later by a 
defined amount (for example: moving a clip four bars later).

K6 repeat
selection

Fast way to repeat selection. Will open dialog allowing you to specify how many 
repeats you want.

L6 duplicate
selection

Duplicates your edit window selection, pasting a copy of the selection right after 
the selection. Can be pressed repeatedly to create multiple copies.

M6 nudge right edge earlier
Useful for making small adjustments to the edges of clips without having to 
zoom in to use the mouse. Goes by current nudge value (which of course can 
be changed using the decrease or increase nudge value shortcuts M4, N4)

N6 nudge right edge later

Useful for making small adjustments to the edges of clips without having to 
zoom in to use the mouse. Goes by current nudge value (which of course can 
be changed using the decrease or increase nudge value shortcuts M4, N4)

O6
extend selection
to
previous These shortcuts extend an edit selection to the next/previous clip or boundary. 

This means edges of clips, clip anchor points, or the next transient if Tab To 
Transient is active. For example, if you are selecting on a kick drum track, it will  
extend the selection to the next kick hit (i.e. transient).

P6
extend selection
to
next

These shortcuts extend an edit selection to the next/previous clip or boundary. 
This means edges of clips, clip anchor points, or the next transient if Tab To 
Transient is active. For example, if you are selecting on a kick drum track, it will  
extend the selection to the next kick hit (i.e. transient).

Q6
move
selection
up

Move selection up one track in the Edit Window. Same function as the “P” key 
when Command Focus is on.

R6 page
up

Easy way to move up the track display in the Edit Window. Same function as the 
Page Up key on the regular keyboard.

A7 save as Save As (works only in Pro Tools)
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B7
import
session
data

Another commonly used File menu function. This will bring up the options 
for importing session data.

C7
paste
special
merge

NOTE: These Paste Special commands are all from the Edit Menu. The “copy” 
command used in all of these Paste Special commands is the regular Copy from 
the Edit Menu, not Copy Special.

If you copy a MIDI clip or selection of MIDI notes in the Edit Window or any MIDI 
editor, this command will merge the notes into another MIDI clip. 

D7 paste special fill selection

In an automation playlist display, you can copy a section of automation data. 
Then, if you make a new selection, this command will paste and repeat your 
copied data to fill to the end of the new selection. A suggested use: If you have 
automated a parameter like a filter to create a special effect like a filter sweep, 
you can use this to repeat it over a selection creating a rhythmic effect with the 
repeated pattern.

E7 paste special to auto Allows you to copy the automation data from one type to another or from one 
track to another in the automation playlist displays.

F7
copy selection
to main
playlist

This is mainly for use when track comping when you have the expanded playlist 
view of a track showing.

G7 rename clip Brings up the rename clip dialog box for each selected clip.

H7
separate
at
selection

Separate Clip at selection point or points.

I7 group
tracks

brings up the Create Group dialog to quickly create groups from selected tracks. 
You can name the group in the already highlighted field, or just use the default 
name for the group.

J7 group
clips

Creates a new Clip Group from selected clips. If you haven’t used this feature, 
it’s a great way to take a collection of clips and make them behave like a single 
clip without having to Consolidate (note: this is different than the Group Track 
function).

K7 ungroup
clips Will ungroup clips that have been put into a clip group.

L7 regroup
clips

Will regroup clips that have been put into a clip group. The function allows you 
to make changes to a collection of clips that have been previously Grouped and 
then Ungrouped. So you can edit individual clips within your Clip Group and use 
this command to put the group back together without having to reselect all of the 
clips.

M7 nudge audio earlier
These are great commands for editing the timing of audio. It slides the audio 
inside the clip body without moving the clip. Very useful in conjunction with the 
decrease/increase nudge value shortcuts.

N7 nudge audio later

These are great commands for editing the timing of audio. It slides the audio 
inside the clip body without moving the clip. Very useful in conjunction with the 
decrease/increase nudge value shortcuts.

O7 select
previous clip Moves your edit selection to the previous or next clip. These can be a useful 

way to navigate along the timeline in Pro Tools. These shortcuts also come in 
handy if you are moving along a track and adjusting the timing of clips.

P7 select
next clip

Moves your edit selection to the previous or next clip. These can be a useful 
way to navigate along the timeline in Pro Tools. These shortcuts also come in 
handy if you are moving along a track and adjusting the timing of clips.

Q7
move
selection
down

Moves the edit selection down to the next track. Same as the “;” key on the 
regular keyboard in Command Focus Mode.

R7 page down Moves down the track display in the Edit Window. Same as Page Down on the 
regular keyboard.
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A8 save The standard Save command from the file menu (Command-S). This will work in 
other Mac programs (as a bit of bonus functionality)

B8 import
audio Brings up Import Audio dialog.

C8 pre/post roll Fast way to toggle Pre Roll on and off instead of using the mouse to click the 
button on the transport (note: turns Post Roll on and off at the same time).

D8
page
scrolling
on

Turns page scrolling on (in the Edit Window). Normally, this command must be 
accessed through the Options menu. Causes screen view to follow along with 
the playback.

E8 page
scrolling off

Turns page scrolling off (in the Edit Window). Normally this command must be 
accessed through the Options menu. Causes screen view to not follow along 
with the playback. Especially helpful when doing detailed editing on a loop and 
you are zoomed in while it is playing

F8 enter The Enter key that is usually only found on Number Pad of a full size keyboard.
Very useful if you don’t have a Number Pad. Also functions as Return. 

G8 hide all floating windows

Will hide (close) all floating windows including plug-ins, floating faders, dialog 
windows, color palette, etc. (a lot easier than clicking a bunch of tiny red buttons 
in the window corners).  Press it again to bring back the last set of open 
windows.

H8 mix/edit window switches back and forth between Mix and Edit windows

I8 suspend
groups

Suspends active groups and activates suspended groups. A typical use would 
be suspending a drum group to adjust the level of one track in the group.

J8 mute
clip

Mutes and unmutes clips.

K8 clip gain
decrease

Nudges the selection’s clip gain up or down for selection.

L8 clip gain increase

Nudges the selection’s clip gain up or down for selection.

M8 nudge earlier Same as the “-” key on regular keyboard or “,” on regular keyboard when in 
Command Focus mode.

N8 nudge later Same as the “+” key on regular keyboard or “.” on regular keyboard when in 
Command Focus mode.

O8 tab to
previous same as Option-Tab on regular keyboard

P8 tab to
next same as Tab on regular keyboard

Q8 zoom
out

The regular zoom in and out, works independent of Commands Keyboard Focus 
mode.

R8 zoom in

The regular zoom in and out, works independent of Commands Keyboard Focus 
mode.
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Chart 1: Hotkey Matrix key layout with row numbers and column letters (used for referencing detailed descriptions in Chart 3)
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